%ANLEJ’ Danley Design Tool 2d

USER MANUAL FOR DDT2D

Welcome to the Danley Design Tool 2D program.

Introduction

DDT2D is a very powerful tool that lets the user visualize how sound propagates from
loudspeakers, including subwoofers, and interacts with sound from other speakers and
with the room. Working in 2D lets the user see phenomena with great detail which when
presented in 3D may be hard to see due to the increased amount of data presented.
Sometimes, 2D is a better way to view things. For example the effect of placing subwoofers
on each side of a stage at 100 Hz (shown below) is very clear in 2D.
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Installation

DDT2D comes as a self-installing program. Simply click on the icon and it will install. The
program requires less than 20 mb of hard drive space.

Getting Started

When you first launch the program you will notice that there are 3 parts to the display. On
the left, at the top of the screen there is the Sound Field window. This is where the 2D
coverage maps are displayed. You can choose the frequency and the resolution of the
display. See the section on the Sound Field window for more information.

Below the Sound Field window is the Frequency Response window where the frequency
response of the system is displayed. The Frequency Response window becomes active
when one or more microphones are placed in the sound field. The response of up to 10
microphone positions can be displayed at once. See the section on frequency response for
more information.
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DDT2D Screen

On the right, there are a number of drop-down tabs allowing the user to design the system
to model. We call this part the Parameters Window.

Moving the Panels
When you see this symbol you can grab it with the mouse and

move the panel anywhere on the screen. this way you can customize the look of your
screen and keep active tools that you use frequently. To return all panels to the default

position click the default panel location button.
PEE 0D
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The Top Level Buttons

Moving the mouse over the buttons on the top left of the screen will display a “roll
over” description of the function of the button. From left to right these are:

=0 D.D.T. 2d 1.25 - Danley Design Tool
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Create a New Project - start with a clean slate!

Open an Existing Project - opens the Windows Browse window

Save a Project - opens the Naming window and allows the user to save a project.
Draw Line - allows user to draw a line freehand in the Sound Field window
Erase Line - click erase line then mouse over the line you wish to remove

Erase All Lines - removes all lines from Sound Field

Measuring Tool - measures distances in Sound Field window. Distance in feet ( or
meters) and time in ms are displayed below the Frequency Response window.

Activate Scroll Bars - if the display is too small to show the entire DDT2D display,
you can activate the Windows scroll bars.

Maximize/Minimize Sound Field Window - clicking this button will enlarge the
Sound Field window to occupy most of the screen. Clicking again will return the
Sound Field to default size.

Default Panel Location - returns all panels to default locations. ( see Moving
Panels)

Memory - records Sound Field and Frequency Response to one of 3 memories. View
using Memory tab.

Sound Field Controls
Frequency- selects the }5 octave center for the sound field simulation
Band Widening - selects the bandwidth of the simulation

Generate - generates the sound field simulation
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Parameter Boxes - shown above, display the position of the cursor. The lefthand
pair of boxes indicate the realtime position in X,Y coordinates of the curser. The
righthand set of boxes indicates the position of the last mouse click. The large box in
the center is the progress box, active while DDT2D calculates the Sound Field

The Frequency Response Window

There are no controls in the frequency response window. To see the frequency response at
any location, or in up to 10 locations, place microphones in the Sound Field. The response
will immediately appear in the Frequency Response Window. Move your curser over a
response curve. The frequency will appear in the grey box, and the amplitude will appear in
the colored box corresponding to the curve.

Frequency response G

158 631
Frequency Mic1: - hic 2: hic 3: hic 4: Mic 5:
970 Hz.  Mic6: Mic 7: | | nice: [N +ic9: wic 10: [ NGN

The Parameters Window
Speakers Tab
Location

Selecting the Speakers tab will display 3 sub menus or tabs, with the Location
tab showing. DDT2D allows the placement of up to 10 full-range speakers in
the Sound Field window
|
Speakers Subs  Miciophones  Draw | Calc | Memory | Options | Project | Key commands | Reflec
Speakers +
Location | Processing | Model
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1 Using the mouse, click on a location in the Sound Field window. Click the
set button to place a speaker in the position selected .

- the small square to the right of the Set button, makes the speaker active
when checked. When checked, the speaker will be displayed in the Sound
Field. When de-selected ( unchecked) the location will remain but the
speaker will be invisible.

@] Mute button, leaves the speaker visible, but mutes the output.

-Phase button, reverses the polarity of the loudspeaker when selected. The
button will turn red when selected

- the next three columns allow for manual placement and orientation of the
speakers. The first column selects the X or horizontal position, and the next
column selects the Y or vertical position on the Sound Field. Note: the use of
the terms horizontal and vertical refer to the axis of the graph and not the
orientation of the speaker. For example, when viewing a speaker in the
plan view, the Y axis represents typically the width of the room. When
viewing the elevation, or side view of a speaker, the Y axis will represent the
vertical dimension. The final column is the rotation of the speaker. In Plan
view, using the angle control will rotate the speaker about its vertical axis,
with a negative angle turning the speaker clockwise. When using a side or
elevation view, the angle control tilts the speaker up or down with a
negative angle pointing it downwards.

- Groups. An individual loudspeaker can be assigned to 1 or all of 4 groups.
All loudspeakers assigned to a group can be controlled as a group, buy using
the controls in the Groups section at the bottom of the Speakers screen.

Groups section

. u - Increment:

Group: 1 = (m) — () 1.0 [

u v

- Gain [dB) Delay(ms) Angle
m [/ o000 2 000 2|0 &

The group can be muted, the polarity of the entire group flipped, the gain
can be changed, delay added and the angle of the speakers in the group
adjusted. Using the 4 boxes between the group select and the increment
boxes moves the entire group around, each click moving the group by the
increment selected in the increment box.

The Master section, to the left of the Groups section adjusts the gain and
delay of all loudspeakers.
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Processing

Selecting the Processing tab brings up a new window where the gain
and delay of a speaker can be adjusted. The set, on/off, mute and
polarity functions remain active. In addition there is a crossover
selector, ( default condition on or active) which allows a crossover to
be part of the processing for a speaker.

Model

When the Model tab is selected a new window is displayed where the
user can select from among the Danley Sound Labs family of full-range
(i.e. not subwoofers) loudspeakers. Each loudspeaker is listed in
both plan view or side view. The set, on/off, mute and

polarity functions remain active.

Subs Tab

Location

The Subs tab/ Location is identical in function to the Speakers Tab described
above. However the user may place up to 20 subwoofers in the Sound Field
window.

Processing

The processing tab is identical in function to the Speakers tab/ Processing
described above.

Model

The Model tab is identical in function to the Speakers Tab/ Model described
above. DDT2D version 1.25 includes 3 of the Danley subwoofers, the TH812,
the DBH 218LC, and the TH118. In addition, we have included an idealized “
true omni” subwoofer.

DDT 2d Manual Page 6



Danley Design Tool 2d

Microphones Tab
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DDT2D allows for up to 10 microphones to be placed in the Sound Field window.

The Microphone tab window is shown above. The small square button turns the
microphone on or off. The colored box with the mic number inside is similar in
operation to the ‘set’ button in the Speaker Tab. Clicking on a location in the Sound
Field then clicking the colored box will place a mic in the location selected. The next
two columns are the location columns. The first column selects the X or horizontal
position, and the next column selects the Y or vertical position on the Sound Field.
Note: the use of the terms horizontal and vertical refer to the axis of the graph and
not the orientation of the microphone.

The boxes on the right set the scale of the Frequency Response graph. The user can
select 3, 6, Or 10 db per division, and the bottom of the graph i.e. 0 on the y axis can
be 80,90 or 100 dBSPL. If the mouse has a scroll wheel, place the mouse over the
Frequency Response screen and click on the Y axis. The curser will turn to an

up/ down arrow and the user can select vertical resolutions other then the 3,6
and 10 dB. Moving the curser to the center of the Frequency Response window and
the curser will return to the default crosshair. Moving the scroll wheel will now
adjust the horizontal axis.

Draw Tab

The Draw tab gives access to a number of drawing tools which let the user create
complex rooms in the Sound Field window. IMPORTANT! The lines drawn with the
tools under the Draw tab, have no acoustic properties. The sound goes right through
them. DDT2D allows for freehand drawing or drawing using the X/Y coordinate
method. See Tutorial #1 for a detailed demonstration on how to draw with the X/Y
coordinate system. Arbitrary shapes, circles and text boxes can be placed on the
Sound Field window
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CALCTab

The CALC tab contains a number of useful tools for sound system and general audio
work. The F-L-T calculator displays the relationship between frequency ( f)
wavelength (L) and period ( t). Enter two of the three variables and the calculator
will display the third. The next calculator displays the relationship between distance
in feet or meters and the time that a sound wave will take to traverse that distance.
There is also a handy feet to meters converter.

The adding dBs tool allows the user to enter 2 decibel values, select somewhere on a
continuum between coherent and incoherent, and the calculator will display the
summation .

Finally there is a Log tool that lets the user enter a ratio of voltages or powers and
the calculator displays the ratio in dB.

Memory Tab

There are 3 memories which can store and retrieve coverage and response curves
for easy comparison.

“2D.D.T. 2d 1.25 - Danley Design Tool
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When you have a coverage map and a response you wish to save, click one of the 3
buttons shown above. Then by selecting the Memory tab you will be able to compare
the curves saved in memory.

Options Tab

The options tab allows the user to set certain parameters for DDT2D. The grids can
be turned on and off, and the user can select between imperial and metric units. In
addition, this is the tab where the crossover controls are located.

Air Attenuation

By selecting this option and entering the temp and humidity DDT2D will accurately
include the effect of air attenuation on the frequency response, per ISO 9613-1.

Crossovers

DDT2D allows the user to build 2 way systems using a variety of crossover options.
In addition, under the Speaker / Processing and Sub / Processing , the user can
choose to turn off or bypass the crossover on any device. The default setting has the
crossover active, or “on”.
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Project Tab

The project tab has the tools for saving and opening DDT2d projects and adding
notations to projects.

Key Commands Tab

The key command tab is simply a listing of the key stroke equivalents or key board
shortcuts.

Reflections Tab

Reflective surfaces can be created in DDT2D using the tool under the Reflections tab.
In the current ( 1.29) release the user is limited to rectangular rooms. Frequencies
below 3kHz can be mapped and the result of the reflections shown in both windows.
The user can make each of the surfaces active or inactive to study the effect of
reflecting surfaces on the response and coverage. The rectangle is formed by
entering the coordinates of the lower left and upper right corner.

Reflections
[vIiF
Left reflection
Right reflection
Top reflection
Bottom reflection

Bottom/left corner

0000 ~ 0000 +

Top/right comer

75000 + 25000 -+

[[] Show points of reflected sources

[[] Show lines of reflected sources
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TUTORIAL 1. A simple sound system

As a way to get familiar with the various parts of DDT2D, lets design and model a simple 2
way sound system. Lets start with a PLAN view of the system. The PLAN view is looking
down from above. With DDT2D you don’t need to build a room unless you want to. You can
examine the way speakers couple, for instance, without building a room first. So lets look at
a few options before we put them in a room. Suppose we are trying to decide if a pair of
loudspeakers would be best placed together in the center of the room, or one on each side
of the stage. Lets assume the the stage is 18 feet wide. Lets first place a loudspeaker on
stage right.

-Click on the Speakers tab on the right hand Variables Window

- Now select the Model tab.
Speakers | Subs | Line aray | Microphones | Draw | Cale | Memory | Options | Project | Key commands | Reflections
Speakers 24
Location | Processing | Model
Ne
Mm@  [Sh-60 Side view v
Om @  [sh-60 Side view o
Oim @ | |sh-60 Side view v
(«) UM/ | Sh-60 Side view v
Om @  [Sh-60 Side view v
@D@@ Sh-60 Side view v
O (@  sh-60 Side view v
(z)Om Sh-60 Side view v
(=) UM/ | Sh-60 Side view v
(o) O (@ | [sh-60 Side view v
Master section Groups section
Gain (dB) D Increment:
m pooo 4 owo:[1 2 @ — @ [o -
=
Delay
0.000 = Gain (dB) Delay(ms) Angle

= m [@ oooo  :|boo 2|0 3

you can see that DDT2D allows you to place 10 loudspeakers and create
groups - more on that later.
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- Lets choose the SH100 from the pull down arrow on the right end of the box
showing the SH60 Side view. Because we are modeling in 2d, the user has to decide
between the side view or the Plan view. For this example we are using the SH100

plan view
Speakers
Location | Processing Model
Ne
ERLETIZ M- 100 Plan vie 3
Om) Sh-60 Plan view A~

Jh-90 Side view
Cim) Jh-90 Plan view

Gh-60 Side view
(] Um) Gh-60 Plan view

O Sh-100 Side view
(5] Sh-100 Plan view

(eJOm (@ | Sh-95 Side view

Selecting the box indicated by the arrow, makes the chosen speaker active. The M button
next to it, is a Mute button, which leaves the speaker on the screen, but mutes the output.
The phase button flips the polarity of the speaker.

Speakers
Location | Processing | Model [
Ne
@ lEMSh- 100 Plan vie 3
Olm) Sh-60 Plan view A~

Jh-90 Side view
D@] Jh-90 Plan view

Gh-60 Side view
COUmME || G0 Plan view

(5] 0@ | [Sh-100 Side view

Sh-100 Plan view
(eJOm (g | [Sh-95 Side view

- Now select the Location tab. This will let us place the loudspeaker on the Sound Field
screen. The first column in the X or horizontal position. The next column is the Y or
vertical position. Remember that this is a 2D model. The words Horizontal and Vertical
are relative! Lets set the position of the first speaker at 20.00, 10.00

- Choose a second SH100 and place it at 20.00, 28.00. You should see something like this.

Sound field
Frequency {Hz): 1000 £ Band wide

402t —
254t —

107 — '
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Note, if you have a scroll wheel on your mouse, you can zoom in and out of
the Sound Field window. Simply place cursor over the Sound Field window
and the scroll wheel will become active. Holding the Left button down while
the cursor is in the Sound Field window will re-position field of view, but keep
all of the actual locations the same. If you don’t have a scroll wheel, the I and
0 keys will also zoom in and out of the Sound Field window.

- Now you can do your first simulation! Press the space bar, or click the
generate key. You will see the 1KHz coverage plot.

[(MEE I ETEY
Sound field
Frequency (Hz): 1000 C: Band widening II!12 act. VI Generate

.'mw

\\\“Q\

[12&44 4:653 [llllIIIIIIIIIIIIIIIIIIIIIIII@ :3215 |41.08

Experiment with different frequencies. Click generate after selecting a new
frequency to plot. 1/12™ of an octave is the highest frequency resolution, possible,
but you can also choose to display the average of the full 10 octave response, shown
below.

[BEE FEE R
Sound field
Frequency {(Hz): 1000 Band widening ’10 oct. V‘ Generate |

W%-IIHIIIIII
- 3 Pi—— |
961t 1 3 R ﬂ-

20.3ft 59.71 99.11t 138.51 =
[78.22 6324 | (AWNNNANNANNANNANNNNNNNNNNNNNN (13845 (4856 |
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Now, lets take a look at the frequency response of our sound system. To do this, we need to
place at least one “microphone” in the Sound Field. Select the Microphones tab.

Microphones &
[ | : 0.00 ~|l0.00 ~| Setfrequency response division:
Mic2 | [ 3@ J[ 6 |[ 1wam |
O (Bwigza| 000 +/0.00 A
O Mi 0.00 ~looo | Setfrequency response floor:
e == sk |[ s |[ 100s |
O [mic4 | 0.00 110,00 A
O [(mie5 | 000 :/0.00 A
O [ mice | 000 + 10,00 A
O [Bsie) 0.00 110,00 A
O e soe ¢
O [ Micg |/0.00 ~110.00 -
C )| © ° 2 000 .

DDT2d allows the user to place up to 10 microphones in the Sound Field window.

Lets place a microphone about 45 feet from the speakers slightly off center. Enter the
numbers 65.00, 17.00 in the two columns. When you click the square box to the left of
Micl1 to activate the mic, you will see a red response curve appear immediately in the
Frequency Response window.

Frequency response b

39 158

Frequency Micl: - Mic 2: Mic 3: Mic 4: Mic 5:

970 Hz.  Mich: Mic 7: I nico: [ tic o tic 10: NG
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This is the frequency response of the system at that point in space. There is clearly allot of
“comb filtering” due to the arrival times from the two speakers. To confirm this you could
simply mute one of the speakers. You will see the response immediately flatten out.

To Mute a speaker, pull down the Speaker tab and click on the @ next to the speaker you
wish to Mute.

You should also notice that the response starts rolling off at around 150 Hz.

Note: When you move your mouse over the Frequency Response window the cursor
becomes a cross, and the frequency at the cursor is displayed in the grey box labeled
frequency at the bottom left of the display. The amplitude or level of each mic is
displayed in the colored box associated with each curve. In the example shown
above, the level at Mic 1is 105 dB SPL at 970 Hz.

-Go to the Options tab and you will see that there is a crossover set at 150 Hz. If you
lower the crossover to its lowest setting of 70 Hz, you will see the frequency
response curve update automatically.

-Now lets place a few more mics just for fun! You can enter x,y coordinates as we did
before, but there is a faster way! Move the mouse to a location in the Sound Field
window where you would like to place a mic, say in front of speaker number 2. Click
on that location, then click on the green box

Mic # 2 will appear in front of speaker#2, and a new, green curve appear in the
Frequency Response window. This is the response pretty much right in front of
speaker # 2. If you wish you can also look a the response in front of speaker #1 as
well, or the response anywhere you wish! Here I have placed a third mic in front of
speaker #1, slightly closer to the speaker.

“0D.D.T. 2d 1.25 - Danley Design Tool
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Sound field
Frequency (Hz): [1250 3 Band widening |1/6 oct. v

Speakers | Subs | Microphones | Draw
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(5] 0m @ | [sh-60 Side v
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-You may recall that when we started this exercise , we set out to see if speakers on

each side of the stage is better then a pair placed in the middle over head. Lets save
this design in memory so that is will be easy to compare it to our next design. Click
the 1 button at the top of the window. This will save this design, the coverage map
and the frequency response screen to the first of 3 available memories.

“0D.D.T. 2d 1.25 - Danley Design Tool

() edis->

-Now, lets try to modify our design to see what would happen if we were to put the
two speakers together hung over the stage. Pull down the Speakers tab and lets
learn a different way to move or place a speaker. Move the mouse to the Sound Field
window. As you move the curser around, you will see the numbers in the left set of
position boxes will change.

Sound field
Frequency {(Hz): 1000 Band widening |1/12 oct. \

127t —
B2 — .

et — [
1

X Position | I |
201t 52.61 85.61

2001 1772 ||

Y Position

-Click at a location close to 20,18. Now pull down the Speakers tab. Click on the set
button next to speaker 1.

Speakers
Location | Processing | Model
Set

Mm@ | |Sh-100 Plan view 3
Mm@ | [Sh-100 Plan view 3

-You will notice that speaker # 1 will jump to this location. You can use this “point
and click” technique to quickly place speakers or microphones anywhere in the
Sound Field window. You can also edit the location using the x and y fields under
the location tab.
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-0k, using what ever technique you wish, lets get the two speakers to 20.00, 18.00
and 20.00, 19.00. This will place the speakers side by side. Click on generate. The
response is much better in the middle, but now there huge notches in the response
on mic # 2 and 3. You can save this design to memory 2. If you select the tab
Memory from the Variables Window, you will see the graphics from the first design.
Clicking on the number tabs allows you to compare the results of the two designs.

BB FEE [0 S

Sound field
Frequency (Hz): 1000 3 Band widening |1/12 oct.

---- Speakers | Subs | Microphones | Draw | Cale | Memory
- Speskers
112 4041 —| ’

Location | Pracessing | Model

- YUm(g 2000 2| [1800
2)Ym@ 2000 2| [19.00
Om@ oo 2 000
[(«)OmE@ 000 + looo
E)0m@ 000 2| [0.00
(6] 0(m 0.00 - oo
Frequency response ES Umf poo 2000

(ea)0m [000 - oo
5 . r [ |

I O [ J@
S

2 il Maste i
-/ s st seston
-—_llI i Gain cB)
40 160 2560 10240 moooo coup:[1 4| [

Frequency M 1_ M 2 Mic 3 Mic4: Mic5: Delay
haino. I i 0. s 4 o, I A Ann < Gain (dB1

3561 61.81 8811 114.31
53.44 5112 || | lea24 2133

o

Maybe the SH100 was not a good choice because although they couple well at low
frequencies, ( see the very close agreement from all 3 mics below 600 Hz) the SH100
is not designed to be “arrayable”. You can clearly see the cancellations in both the
response and in the coverage. Lets try a third design. If you go to the Speakers tab,
you can simply click on Model and select different speakers. Lets try a pair of SH50s,
plan view. You will need to zoom in to see it, but if you place the two SH50 at the 18
and 19 ft locations they will hit each other. So lets put one at 18, and one at 19.80 ft.
Then, because the SH50 is a 50 degree cabinet, using the Angle adjustment tool, set
speaker 1 to an angle of -25 degrees, and speaker 2 to an angle of 25 degrees. Now
the two can be moved together so that they are tight packed. You should end up
with the two speakers at 20. 18.9 and 20, 19.8 or some set of coordinates where the
speakers are .9ft apart. Notice the improved coverage and the smooth response as
the two speakers combine. Save this design to memory 3.
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-So, now if you select the Memory tab from the “variables” window, by choosing tab
1, 2 or 3, you should be able to review your 3 designs! Take this opportunity to
save your design by clicking on the disk icon ( save current project) or by clicking on
the Project tab. You might consider naming this project my_first_ model_plan or
something to that effect to remind yourself that this is a plan view of your system.

-Lets take our exploration one step further. Itis pretty clear that putting a pair of
SH50 speakers in the center of our room will be the best way to get the coverage and
response we want. But what if we wanted to add a subwoofer. Should we fly it up in
the ceiling or place it on the ground?

-The first step is to re- orient ourselves. In the last part of this exercise, we were
looking down from the top at the plan view. Even though we did not actually build a
room, the y axis was representing the left - right dimension of the room and the x
axis represented the front - back dimension. Now we are going to look at the
elevation view. The y axis will be the up-down and the x will be the front- back. So
lets clear the Sound Field screen by turning off our speakers and microphones.
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-Lets try the Draw tool. DDT2d allows you to draw rooms of any shape to get a
better handle on coverage. These “rooms” or shapes do not have any acoustical
properties at all. DDT2d does allow you to build rectangular rooms which do have
acoustical properties, but we will cover that feature later.

add line by coordinates

Lets assume that our room is 75 feet long and |

25 feet high. We can draw a rectangle of those 1 ” 2 w2
dimensions using the tools available under the Jloco Zjpoo 3] 7400 oo
Draw tab. You can draw lines freehand using
the Draw Line tool, but lets use the add line by
coordinates tool. Lets draw the floor first. x1 should be 0.00, y1 0.00, x2 75.00 and
y2 0.00. When you click on “line from (x1,y2) to (x2,y2) a horizontal line will
appear in the Sound Field window. This represents the floor of our room. Next add
aline from (0.00,0.00) to (0.00,25.00). This should draw the front wall. The ceiling
should be (0.00,25.00) to (75.00,25.00) and the back wall should be (75.00, 25.00)
to (75.00, 0.00). When you are done the room should look like this.

Line from (+1.41)to (22) ]

Sound field

Frequency {Hz): 1000 £ Band widening | 1/12 oct v

301t —

153 —

06t —

| | | |
oft 29.5ft 59.11t 88.61t =

’ 76.18 564 (TTTTITTTTTTITTITTTTTIT kX 41

-Now we can place our speakers. Choose the Speaker tab, and select SH50, side view.
Lets place one, 10 feet from the front wall, and 2 ft down from the ceiling. We could
point at the desired position and click set, but entering the coordinates is more
precise. The coordinates should be (5.00, 23.00). Remember our design called for
two SH50s side by side. Lets add a second speaker at the same location. Even
though we cant see the second speaker from this perspective, DDT2d will accurately
model the sound pressure level and frequency response of the combined speakers.
Notice in the Location tab under Speakers, you can assign any speaker to one of 4
groups. This is a convenient way to change the position or processing of an entire
cluster of speakers. Lest assign our two SH50s to group 1. If we click Generate, we
can see that we need to angle our speakers down to cover the audience which,
presumably, will be on the floor! Now use the tool at the bottom of the Speakers
window labeled “Group Section”. Make sure that Group 1 is selected, and enter -20
in the angle box. Both of the SH50s will now point 20 degrees down. Re-generate
the coverage , and you will see that the speakers now point at the floor!

-Lets add a few mics to check the response. Place one mic towards the back of the
room and one about half way down. You should see that the response looks virtually
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the same in both positions, the nearer one being somewhat louder. Your model
should look something like this.

Sound field

Frequency (Hz): 1000 2 Band widening |1/12 oct. v
l r

12 323t _:

| | | |
17.71 43.91 70.2ft 96.4ft -

122.41 29.95 (WNNNNRNNNNRNN RN NN NN (7263779 | (4101049

Frequency response &

126
120

114
108
102
96

Frequency Mic1:_ Mic 2: 1T858 Mic 3: Mic4: Mic 5:
597 Hz.  Mic6: Mic 7: I nic o: I ico: wic 10: [N

-Now, finally, we can add our subwoofer and experiment with location. Lets start
with the Sub on the floor. Lets choose the TH118, and place it under the SH50s on
the floor. Because of the size of the TH118, the Y axis will need to be about 1.4 ft to
show it sitting on the floor. Make sure that the crossover buttons are selected
(default condition) on both the SH50s and the TH118. The crossover select button is
under the Processing tab. Reviewing our Danley Sound Labs Spec sheet, we see that
the SH50is rated down to 50 Hz and the TH118 is rated up to 225 Hz. This means we
could select a crossover frequency somewhere between 80Hz and 225 Hz. This is
one of the strengths of using DDT2D to evaluate a sound system. You can try different
crossover frequencies, different slopes and different alignments to find the best
possible set of parameters. Lets start with a crossover set to 100Hz. Remember, the
crossover point is set under the Options tab.
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D.D.T. 2d 1.25 - Danley Design Tool

Sound field:
Frequency: 100 Hz - Band Widening: 2 oct.

HEE.

12 93 01

™ [ [
106 12.4t — -EF
L

0.9t —
100

Frequency response:

Choosing the frequency of 100 Hz and setting the Band Widening to 2 octaves will
let you see how the SH 50s and the TH118 interact. You can see from the Sound Field
that there is considerable interference between the two. It can also be seen in the
frequency response. Adjusting the gain, delay and crossover characteristics can
improve this system significantly. However, it is unlikely that you will find a
combination of settings where the response at the 2 microphones will be the same.
Lets look what happens if you move the sub up to the ceiling with the SH50s.
Moving the Sub to the coordinates of 6.00 / 20.30 with a -20 angle (not really
necessary)
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D.D.T. 2d 1.25 - Danley Design Tool

Sound field:
Frequency: 100 Hz - Band Widening: 2 oct.

" _-.I‘.-..r
- _‘.II.."r
e “iiii-f

|
-5.21t 17.6ft 40.81

|
B63.71

Frequency response:

Frequency

Moving the Sub to the ceiling immediately makes the response at the two mics
virtually identical except for the level loss due to the difference in distance between
the mics and speaker cluster. Again, feel free to experiment with different settings of
the crossover, levels and delay. You may be able to improve on this design!Here is
my best effort!

D.D.T. 2d 1.25 - Danley Design Tool

Sound field:
Frequency: 100 Hz - Band Widening: 2 oct.

M2 598 l.-—-——_-
1
- ‘I..."

0ot —

Frequency
303 Hz.
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Lets do one more thing. Because our room is ( conveniently) rectangular, we can
actually look at what effect the room will have on our design. This is a worst case
condition, where each of the surfaces is assumed to be 100% reflective. Select the
Reflections tab. If you enter the coordinates of the lower left corner, 0, 0 and the top
right corner 75, 25 you will create a rectangle of reflective surfaces which overlays
the room we built earlier.

Of course you will notice immediately that our carefully eﬂec“°"s

tuned and “tweaked” sound system looks horrible. This 7] Lotrfisoion

is what it would look like in a reverb chamber with (4 Fight efeton
everything totally reflective. In the real world it will not 2 "="
be this bad. You will also notice that the Sound Field takes

considerably longer to calculate.

Bottom/left comer

0.000 £ //0.000 E

Top/right corner

75000 225000 <

v

[[] Show points of reflected sources

[] Show lines of reflected sources

D.D.T. 2d 1.25 - Danley Design Tool

Sound field:
Frequency: 100 Hz - Band Widening: 2 oct.

N2 1901 — n
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Tutorial #2 A Cardioid Bass Array

As a way to get familiar with the operation of DDT2D, lets
start by modeling a simple 3 box Cardioid bass array.

-Select the Subs pop down menu. You will see three tabs, Location, Processing and
Model. Select Model. Lets use the sub labeled TH118. We will be using 3 subs in
our model, so make sure that subs 1,2 and 3 are all set to the TH118 sub. Now
select the Location tab. Set the fields in the first 3 subs as shown below.

Subs
Location | Processing | Model

~ Groups
HE Angle 1.2 3 4
O¥m@ | sooo z|fioooo 3|0 30000
)¥Ym@ 2600 ;|50 :|[1g0 ;] OOO0O0
GI¥Ym@E@ [pooo  s|feso0  :|/0 20000
COUmE@ [pooo  s|jpooo :|/0 20000
EUm@ | jpooo :|pooo z/0 ;0000

This will place 3 TH118 subs in the Sound Field with the center one pointing
backwards from 1&3.

- Now pull down the Processing tab and set the delay of TH118 #2 to 2.20 ms.

- Turn off the crossover by de-selecting the crossover box

-Flip the polarity of the center TH118

- In the Sound Field set the frequency to 80 Hz with the Band Widening to 1 octave.

- Generate a Sound Field NOTE!! The screen will likely be totally black if you generate
a Sound Field with out flipping the polarity of the center sub. You have essentially
gone off the top of the amplitude scale. Reduce the drive level to all 3 subs and the
Sound Field will map normally.

- A convenient way to optimize your Cardioid array is to use the microphones.
- Select the Microphones Tab

- Click somewhere in front of the array then click on a colored microphone box. THis
will place a microphone in front of the array. Now click somewhere behind the
array and click on another colored mic box. A second mic will appear and you will
now see the response in front of the array and the response behind the array.

Using the delay, and level adjustments you can fine tune the array.
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D.D.T. 2d 1.25 - Danley Design Tool

Sound field:
Frequency: 80 Hz - Band Widening: 1 oct.

T2 5211
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Your cardioid array should look something like this. Have fun experimenting!
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